
A Mechanical Component
The following detailed example consists of a plane stress analysis of a mechanical component. The 
component is cut from a 4-mm steel plate, and the thickness is small compared to its extent in the 
xy-plane. This aspect along with the fact that the applied loads lie in the xy-plane mean that you can 
assume that the out-of-plane stress is negligible. The Plane Stress application mode works under this 
assumption.

This example also introduces the seven basic analysis types available in the Structural Mechanics 
Module: 

• Static analysis

• Eigenfrequency analysis

• Damped eigenfrequency analysis

• Time-dependent analysis

• Frequency response analysis

• Parametric analysis

• Quasi-static transient analysis

In the static, time-dependent, frequency response, parametric, and quasi-static analyses, the model 
contains a load to the lower-right end of the component. In all analyses the component is clamped on 
the left-hand side. 

Static Analysis
A static analysis has no explicit or implicit time dependencies. This situation corresponds to the steady 
state of a transient analysis with constant boundary conditions and material properties.

The purpose of this analysis is to:

• Find the maximum stress level and compare it with the material’s yield strength

• Find the static deflection at the point where the load is applied and compare it with the time-
dependent analysis.

The Model Library note immediately below appears in the discussion of every model. The path indicates 
the location of the model file on the Model Library page in the Model Navigator.

Model Library Path: Structural_Mechanics_Module/Tutorial_Models/component_static

MODEL DEFINITION
The model starts with a mechanical component whose shape and overall dimensions are shown in the 
following figure. It is possible to create the geometry in a CAD package and import it into COMSOL 
Multiphysics as a DXF file.
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Some key parameters for the model:

Material

• Structural steel as taken from the material library

• Thickness of 4 mm

Load
A 900 N force in the x direction on the inside of the right end

Constraints
The left edge is fixed.

RESULTS

After the analysis you find that the von Mises effective stress has a maximum value of 2.8·108 N/m2 = 
280 MPa, which, compared with the material’s yield strength of 350 MPa, results in a utilization factor of 
80%.

The analysis also gives the static displacements at the bottom end of the edge where the load is 
applied:

RESULT x DIRECTION y DIRECTION

Displacement 6.89e-4 m 1.14e-3 m

Now take a step-by-step look at how to achieve these results using the Structural Mechanics Module.

MODELING USING THE GRAPHICAL USER INTERFACE

Model Navigator
1 In the Model Navigator go to the New page, then select 2D from the Space dimension list.

2 On that same page go to the list of application modes and select 
Structural Mechanics Module>Plane Stress>Static analysis.
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3 Click OK to close the Model Navigator.

Geometry Modeling
Instead of drawing the geometry directly in the user interface, you can import a DXF file.

1 From the File menu select Import>CAD Data From File.

2 The Import CAD Data from File dialog box appears. Open the DXF file 
component_geometry.dxf, which is located in
/models/Structural_Mechanics_Module/Tutorial_Models in the COMSOL installation 
directory.

3 Click Import to close the dialog box, then click the Zoom Extents button on the Main toolbar to 
view the entire geometry.

4 Select all the lines in the drawing by clicking the left mouse button and dragging a rubber-band box 
that encloses all the edges (or use the shortcut key Ctrl+A).

5 Construct a solid from the edges imported from the DXF file. To coerce the edges to a solid, click the 
Coerce to Solid button in the Draw toolbar.

6 Split the solid by clicking the Split Object button in the Draw toolbar to create independent objects 
for the holes.

7 Click the Difference button on the Draw toolbar to cut out the hole in the geometry.
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Physics Settings

Application Mode Properties

Set the analysis type to static (the analysis type is already static in this model, so this step is not 
necessary).

1 From the Physics menu select Properties to open the Application Mode Properties dialog box.

2 The Analysis type list defines which analysis to perform and some other properties for the analysis. 
Because you selected a static analysis from the Model Navigator, the analysis type is already 
defined as being Static.

Boundary Settings

In boundary mode you specify loads and constraints. By default all edges are free, which means that 
there are no loads or constraints. Loads can be defined as force per area (using the thickness) or as 
force per length. The default is force per length, which this example uses.

The total static force on Edge 12 on the lower right end is 900 N. This results in a distributed force 
along the edge, which is 15 millimeter long, of 60 kN/meter. The left edge is fixed in both directions.

1 Open the Boundary Settings dialog box by going to the Physics menu and selecting Boundary 
Settings.

2 Select Boundary 1. Click the Constraint tab, then select Fixed from the Constraint condition list.

3 Select Boundary 12. Click the Load tab and enter 60e3 in the Fx edit field.

BOUNDARY 1 BOUNDARY 12

You have set the boundary conditions according to the following table:
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Page Constraint Load

Constraint 
condition

Fixed Fx 60e3

4 Click OK to close the Boundary Settings dialog box. 

Subdomain Settings

In subdomain mode you specify material properties and element order. The material properties are 
selected from the material library or entered explicitly by typing the corresponding value or expression. 
This example uses the material library. Before you can use a material from the library, you must add it 
to the geometry. Do so from the Options menu or directly from the Subdomain Settings dialog box.

1 Select Subdomain Settings from the Physics menu.

2 Select Subdomain 1.

3 Click the Load button on the Material page to open the Materials/Coefficients Library dialog 
box.

4 Select Structural steel from the Basic Material Properties folder in the Materials list and click 
Apply.

5 Click OK to close the Material/Coefficients Library dialog box. Structural steel is now selected 
in the Library material list in the Subdomain Settings dialog box.

6 Type 4e-3 in the thickness edit field.

You frequently encounter tables such as this one both in the remainder of this chapter and 
throughout the Model Library. The row marked “Page” indicates on which page in the dialog box you 
find the setting.

You have now added the structural steel material to the geometry, an entry that you can see in the 
Model part of the Materials list.
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In tabular form, the material settings are:

SUBDOMAIN 1

Page Material

Library material Structural steel

thickness 4e-3

The Element page shows the shape functions currently in use in the selected subdomain. The shape 
functions define polynomials used in interpolating the dependent variables. Typically, you do not need 
to change this setting.

The default element type is quadratic Lagrange elements. They use 2nd-order polynomials, which is 
often a good trade-off between memory usage and accuracy. You can use linear Lagrange elements to 
reduce memory consumption when accurate stress or strain results are not required. 

Mesh Generation
The Free Mesh Parameters dialog box, found on the Mesh menu, gives access to a number of 
parameters that control the mesh’s density and gradation. Use the default mesh parameters.

1 Select Free Mesh Parameters from the Mesh menu to look at the Free Mesh Parameters dialog 
box.

2 Click OK to use the default mesh settings.

3 Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.
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Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in the Solver 
Parameters dialog box. This option is enabled as the default, so there is no need to change the solver 
settings because stationary is the solver associated with the static analysis type.

To compute the solution, either click the Solve button (=) on the Main toolbar or select Solve Problem
from the Solve menu.

Postprocessing and Visualization
In Postprocessing mode you can, for example, add additional plot types and set parameters for plots. 
The postprocessing utilities can visualize any expression containing, for example, the solution variables, 
their derivatives, and the space coordinates. Many frequently used expressions are predefined as 
postprocessing variables, and they are directly available from lists in the Plot Parameters dialog box.

As soon as the solution is ready, a default plot appears. In the Plane Stress application mode the 
default visualizes the von Mises effective stress. Plot the von Mises stress together with the deformed 
shape of the component:

1 Select Plot Parameters from the Postprocessing menu.

2 On the General page select the Deformed shape and Surface check boxes.

3 Click OK to close the Plot Parameters dialog box.

4 Click the Zoom Extents button on the Main toolbar.
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The deformation is exaggerated using automatic scaling. You can control the scaling of the deformation 
from the Plot Parameters dialog box on the Deform page.

Eigenfrequency Analysis
An eigenfrequency analysis finds the eigenfrequencies and modes of deformation of a component. The 
eigenfrequencies f in the structural mechanics field are related to the eigenvalues λ returned by the 
solvers through

In COMSOL Multiphysics you can choose between working with eigenfrequencies and working with 
eigenvalues according to your preferences. Eigenfrequencies are the default option for all application 
modes in the Structural Mechanics Module.

The purpose of the following eigenfrequency analysis is to find the six lowest eigenfrequencies and 
corresponding mode shapes.

Model Library Path: 
Structural_Mechanics_Module/Tutorial_Models/component_eigen

MODEL DEFINITION
The geometry, material, loads, and constraints are the same as for the static analysis; see the 
description on page 17 for details.

RESULTS
The first six eigenfrequencies are:

EIGENFREQUENCY 
NUMBER

FREQUENCY

f1 300.67 Hz

f2 1346.42 Hz

f3 3456.12 Hz

f4 4405.38 Hz

f5 8410.73 Hz

f6 11 kHz
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MODELING USING THE GRAPHICAL USER INTERFACE

Model Navigator
The eigenfrequency analysis is described as if it were done after the static analysis described on page 
17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis.

Physics Settings
This model uses the same material, loads, and constraints as the static analysis.

Application Mode Parameters

Change the analysis type to eigenfrequency analysis:

1 From the Physics menu, choose Properties to open the Application Mode Properties dialog box.

2 Select Eigenfrequency from the Analysis type list; then click OK.

Mesh Generation
This model uses the same mesh, so there is no difference from the static analysis.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in the Solver 
Parameters dialog box. This option is enabled as the default, so there is no need to change the solver 
settings. The eigenfrequency solver is the solver associated with the eigenfrequency analysis type.

Examine the eigenfrequencies solver parameters

1 From the Solve menu, choose Solver Parameters to open the Solver Parameters dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 

The Eigenfrequency solver is already selected through the Auto select solver option. The number 
of eigenfrequencies to compute is controlled from the General page. Use the default settings to 
solve for the six lowest eigenfrequencies.
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2 Click OK to close the Solver Parameters dialog box.

3 To compute the solution, either click the Solve button (=) on the Main toolbar or select Solve 
Problem from the Solve menu.

Postprocessing and Visualization
You can select which eigenfrequency to work with from a list on the General page in the Plot 
Parameters dialog box. The default plot shows the eigenmode corresponding to the lowest 
eigenfrequency. The eigenmodes are scaled (normalized) so the size of deformations should be 
compared only within an eigenmode and not among modes.

1 Choose Plot Parameters from the Postprocessing menu.

2 Select the Deformed shape check box on the General page.

3 Select the second eigenfrequency from the Eigenfrequency list.

4 Click the Surface tab and select Total displacement from the Predefined quantities list.

5 Click OK to close the Plot Parameters dialog box to look at the mode shape of the second 
eiegenfrequency.
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Time-Dependent Analysis
A time-dependent analysis solves for the transient solution of the displacements and velocities as 
functions of time. The material properties, forces, and boundary conditions can vary in time.

The purpose of this analysis is to find the transient response from a harmonic load with the same 
amplitude as the static load during the first two periods. The excitation frequency is 500 Hz, which is 
between the first and second eigenfrequency found in the eigenfrequency analysis.

Model Library Path: Structural_Mechanics_Module/Tutorial_Models/component_transient

MODEL DEFINITION
The geometry, material, and constraints are the same as for the static analysis (see the static 
description on page 17 for details).

Load
This model uses a harmonic load with an excitation frequency of 500 Hz on the same edge and with the 
same amplitude as the static problem. The expression for the load can be written

where t denotes the time.

Damping
Damping is important in a transient analysis but can be difficult to model. For transient analysis, the 
Structural Mechanics Module supports Rayleigh damping and loss factor damping. It is also possible to 
use no damping.

This model uses Rayleigh damping, where you specify damping parameters that are proportional to the 
mass (αdM) and stiffness (βdK) in the following way:

where C is the damping matrix, M is the mass matrix, and K is the stiffness matrix. The damping is 
specified locally; you can specify different damping parameters in different parts of the model.

You leave the damping parameters at their default values from the previous analyses because they are 
used only for transient and frequency response analyses.

To find good values for the Rayleigh damping, you can use the relations between the critical damping 
ratio and the Rayleigh damping parameters. It is often easier to interpret the critical damping ratios, 
which are given by

where ξi is the critical damping ratio at a specific angular frequency ωi. Knowing two pairs of 
corresponding ξi and ωi results in a system of equations

with the damping parameters as the unknown variables.

The structure has a constant damping ratio of 0.1. Select two frequencies near the excitation frequency, 
200 Hz and 600 Hz, to calculate the damping parameters. You can do this in COMSOL Script or MATLAB 
with the following commands:

b=[0.1;0.1];
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A=[1/(2*200*2*pi) 2*pi*200/2; 1/(2*600*2*pi) 2*pi*600/2];
% A*damp=b
damp=A\b;
alphadM=damp(1)
betadK=damp(2)

The result is αdM = 1.88e2, βdK = 3.98e-5.

For more information see the section “Damping” on page 121.

RESULTS
The following plot shows the x- and y-displacements at the bottom end of the edge where the load is 
applied as a function of time:

MODELING USING THE GRAPHICAL USER INTERFACE

Model Navigator
The time-dependent analysis is described as if it were done after the static analysis described on page 
17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis (see the description on page 17 for details).

Physics Settings

Application Mode Parameters

Change the analysis type to time-dependent analysis:

1 Select Properties from the Physics menu to open the Application Mode Properties dialog box.

2 Select Time dependent from the Analysis type list.

3 Click OK.

The Analysis type list defines which analysis to perform and which equation to solve. 
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Boundary Settings

The force at the right end is harmonic with the same amplitude as the force in the static case and with a 
frequency of 500 Hz,

Use the unit syntax in COMSOL Multiphysics to specify the force in kN/m and the frequency in Hz. The 
variable t is used by COMSOL Multiphysics to denote the time in second. You specify the time steps in 
the Solver Parameters dialog box, which will be explained later in this model.

The left edge is still fixed in both directions.

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the Physics menu.

2 Set boundary conditions according to the following table and then click OK:

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint 
condition

Fixed Fx 60[kN]*sin(2*pi*500[Hz]*t)

Fy 0

Subdomain Settings

The material properties are the same as in the static and eigenfrequency analyses. 

1 Select Subdomain Settings from the Physics menu.

2 Click the Damping tab and enter the damping properties according to the following table; when 
done, click OK.

SETTINGS SUBDOMAIN 
1

Page Damping

αdM 1.89e2

βdK 3.98e-5
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To specify the initial values, click the Init tab.

In this case the initial deformation and velocity are zero, which are the default values. 

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in the Solver 
Parameters dialog box. The option is enabled as the default, so there is no need to change the solver 
settings. The time-dependent solver is the one associated with the time-dependent analysis type. 
Solving for two periods with an excitation frequency of 500 Hz means solving for 4 ms.

Specify the time-dependent solver parameters:

1 Choose Solver Parameters from the Solve menu.

2 Type 0:1e-4:4e-3 in the Times edit field. This means that the solution is saved every 0.1 ms 
during the total solution time of 4 ms.

3 Type 1e-9 in the Absolute tolerance edit field. This is important for an accurate analysis (the 
absolute tolerance must be smaller than the displacements).
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4 Click OK.

5 Compute the solution by clicking the Solve button (=) on the Main toolbar or by selecting Solve 
Problem from the Solve menu.

Postprocessing and Visualization
You have access to the solution at all the computed time steps by going to the Plot Parameters dialog 
box, then the General page, and selecting them from the Output time list. The default plot shows the 
last time step.

For a more quantitative view of the time evolution of the displacement, plot a graph of the 
displacements in the x and y directions at the lower-left corner as a function of time.

1 Select Domain Plot Parameters from the Postprocessing menu.

2 Go to the General page and select all the time steps from the Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 from the Point selection list.

5 Select x displacement from the Predefined quantities list.

6 Click Apply to plot the x-displacement.

7 Click the General tab and then select the Keep current plot check box.

8 Click the Point tab and then select y displacement from the Predefined quantities list.

9 Click Apply to plot the y-displacement.
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10 Click OK to close the dialog box.

Frequency Response Analysis

INTRODUCTION
A frequency response analysis solves for the steady-state response from harmonic excitation loads. The 
loads can have amplitudes and phase shifts that depend on the excitation frequency, f:

where F(f) is the amplitude and FPh(f) is the phase shift of the load.

The purpose of this analysis is to find the transient response from a harmonic load with an excitation 
frequency in the range 200–600 Hz, which is near the first eigenfrequency found in the eigenfrequency 
analysis.

Model Library Path: Structural_Mechanics_Module/Tutorial_Models/component_frequency

MODEL DEFINITION
The geometry, material, and constraints are the same as for the static analysis (see the static 
description on page 17 for details).

Loads
This model uses a harmonic load with an excitation frequency between 200 and 600 Hz on the same 
edge and with the same amplitude as the static problem.

Damping
Damping is modeled using Rayleigh damping in the same way as for transient analysis (see page 29 for 

details): αdM = 189, βdK = 3.98·10-5

RESULTS
The x- and y-displacements at the bottom end of the edge where the load is applied as a function of 
excitation frequency appear in the following figure:
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There is a peak near the first eigenfrequency where the steady-state response is as much as eight 
times higher than the static displacement. The amplitude for 500 Hz is below the transient response, 
which is natural because the damping reduces the transient effects.

MODELING USING THE GRAPHICAL USER INTERFACE

Model Navigator
The frequency response analysis is described as if it were done after the static analysis described on 
page 17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis (see the static description on page 17 for details).

Physics Settings

Application Mode Parameters

Change the analysis type to frequency response analysis.

1 Choose Properties from the Physics menu to open the Application Mode Properties dialog box.

2 Select Frequency response from the Analysis type list.

3 Click OK.

Boundary Settings

Use the same amplitude as for the time-dependent analysis without any phase shift, which is the 
default setting. The left edge is fixed in both directions. In the transient analysis you entered the 
harmonic excitation load explicitly. The frequency response analysis uses a harmonic assumption and 
therefore you only need to specify the amplitude of the load, F.

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the Physics menu.

2 Set boundary conditions according to the following table; click OK when done.

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint 
condition

Fixed Fx 60e3

The Analysis type list defines which analysis to perform and which equation to solve.
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Subdomain Settings

The material properties and damping parameters are the same as in the time-dependent analysis on 
page 22.

Computing the Solution
Usually when performing a frequency response analysis you want to sweep over a frequency range. This 
can be done using the parametric solver. The analysis type controls which solver to use through the 
Auto select solver option in the Solver Parameters dialog box. This option is enabled as the default, 
and there is no need to change the solver settings. The parametric solver is the one associated with the 
frequency response analysis type. Solving for two periods with an excitation frequency of 500 Hz means 
solving for 0.004 s.

Specify the parametric solver parameters.

1 Select Solver Parameters from the Solve menu to open the Solver Parameters dialog box.

2 Go to the General page and enter freq_smps in the Parameter name edit field.

3 Enter 200:10:600 in the Parameter values edit field to specify an excitation frequency from 
200 Hz to 600 Hz in steps of 10 Hz.

4 Click OK to close the Solver Parameters dialog box.

5 Select Scalar Variables from the Physics menu to open the Application Scalar Variables dialog 
box.

If you only want to use the parametric solver to sweep another parameter than the excitation 
frequency, specify the same Analysis type and enter the other parameter in the Parameter name
edit field. You specify the excitation frequency in the Application Scalar Variables dialog box.
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You specified a sweep using freq as the Name of the parameter in the Solver Parameters dialog 
box, which replaces the value of the Excitation frequency specified in the Application Scalar 
Variables dialog box.

6 Click OK to close the Application Scalar Variables dialog box.

7 To compute the solution, either click the Solve button (=) on the Main toolbar or select Solve 
Problem from the Solve menu.

Postprocessing and Visualization
To view the solution at all the different excitation frequencies, open the Plot Parameters dialog box, 
go to the General page and select among those frequencies. The default plot shows the von Mises 
stress for the last excitation frequency in the list.

1 Select Plot Parameters from the Postprocessing menu.

2 Check Deformed shape plot.

3 On the Surface page, in the Surface Data tab, select von Mises stress from the Predefined 
quantities list.

4 Click OK to close the dialog box.

The result of a frequency response analysis is a complex time-dependent displacement field, which 
can be interpreted as an amplitude, uamp, and a phase angle, uphase. The actual displacement at any 
point in time is the real part of the solution

The software can visualize the amplitudes and phases as well as the solution at a specific angle 
(time). The Solution at angle parameter, which you can find on the General page, makes this 
easy. When plotting, COMSOL Multiphysics multiplies the solution by , where is the angle in 
radians that corresponds to the angle specified in degrees in the Solution at angle edit field. The 
plot shows the real part of the evaluated expression

The angle  is available as the variable phase (radians) and can be used in plot expressions.
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For a more quantitative view of the frequency evolution of the displacement, plot the x- and 
y-displacement amplitude at the lower-left corner as a function of the frequency.

1 Select Domain Plot Parameters from the Postprocessing menu.

2 Go to the General page and select all the excitation frequencies in the Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 from the Point selection list.

5 Select Disp. amplitude x-dir. from the Predefined quantities list.

6 Click Apply to plot the x-displacement amplitude.

7 Click the General tab and then select the Keep current plot check box.

8 Click the Point tab and then select Disp. amplitude y-dir. from the Predefined quantities list.

9 Click Apply to plot the y-displacement amplitude.

10 Click OK.

Parametric Analysis
A parametric analysis solves for the static response as a function of a parameter. You freely define the 
parameter name and what it affects; it can be a material property, a load parameter, or something 
else.

The purpose of this example is to find the static response as a function of the direction of the force. The 
force is applied at the same edge as in the static analysis.
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Model Library Path: Structural_Mechanics_Module/Tutorial_Models/component_parametric

MODEL DEFINITION
The geometry, material, and constraints are the same as for the static analysis (see the description on 
page 17 for details).

Load
This model uses a static load on the same edge and with the same magnitude as in the static model. 
The force is free to act in any direction.

RESULTS
The x-displacement at the bottom end of the edge where the load is applied as a function of the 
direction of the force (α) is shown in the following plot:

MODELING USING THE GRAPHICAL USER INTERFACE

Model Navigator
The parametric analysis is described as if it were done after the static analysis on page 17, so the Plane 
Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis (see the description on page 17 for details).

Physics Settings

Application Mode Parameters
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Change the analysis type to parametric analysis.

1 Select Properties from the Physics menu to open the Application Mode Properties dialog box.

2 Select Parametric from the Analysis type list; then click OK.

Boundary Settings

This model uses the same magnitude as for the static analysis, but the direction α is added as the 
parameter to vary. The force is divided into its x- and y-components as a function of the force direction, 
α:

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the Physics menu.

2 Set boundary conditions according to the following table:

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint 
condition

Fixed Fx 60e3*cos
(alpha*pi/180)

Fy 60e3*sin
(alpha*pi/180)

Because the cosine and sine functions take radians as input, a transformation from degrees to radians 
is done to be able to vary α from 0 to 360°.

Subdomain Settings

The material properties are the same as in the static analysis on page 22.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in the Solver 
Parameters dialog box. This option is enabled as the default so there is no need to change the solver 
settings. The parametric solver is the one associated with the parametric analysis type. 

Specify the force direction α as the parameter to vary between 0 and 360°.

1 Choose Solver Parameters from the Solve menu to open the Solver Parameters dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 
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2 In Parameter, enter alpha in the Parameter name edit field.

3 Enter 0:10:360 in the Parameter values edit field to specify the direction of the force between 0°
to 360° in steps of 10°.

4 Click OK to close the Solver Parameters dialog box.

5 To compute the solution either click the Solve button (=) on the Main toolbar or choose Solve 
Problem from the Solve menu.

Postprocessing and Visualization
To view the solution for all different directions of the force, open the Plot Parameters dialog box, go to 
the General page, then select from the Parameter value list. The default plot shows the von Mises 
stress for the last direction angle alpha in the list.

For a more quantitative view of the angle evolution of the displacement, plot the x-displacement at the 
lower-left corner as a function of the force direction.

1 Select Domain Plot Parameters from the Postprocessing menu.

2 Select all load direction angles in the Solutions to use list on the General page.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 in the Point selection list.

5 Select x-displacement from the Predefined quantities list.

6 Click Apply to plot the x-displacement.
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7 Click OK.

Quasi-Static Transient Analysis
A quasi-static transient analysis solves for the transient response where the dynamics of the structure 
are static compared to some other much longer time scale. In this example, a transient temperature 
problem is coupled to the structure, and the temperature problem has a much longer time scale than 
the dynamics of the structure.

The goal of this analysis is to find out for how long time the component can be exposed to a 
temperature of 500 °C before the x-displacement of the loaded edge increases by 30% compared to the 
static displacement without thermal expansion.

Model Library Path: Structural_Mechanics_Module/Tutorial_Models/component_quasi_static

MODEL DEFINITION
The geometry, material, and constraints are the same as for the static analysis (see the description on 
page 17 for details).

The boundary conditions for the temperature problem are:

• The left edge has fixed temperature of 20 °C

• The loaded edge has fixed temperature of 500 °C

• All other edges and both sides of the plate are cooled convectively with:

- External temperature, Tinf = 20 °C

- Heat transfer coefficient, h = 5 W/(m2·°C)

The initial conditions is:

• T = 0 °C

RESULTS
In the following figure you can see a plot of the x-displacement versus time at the bottom end of the 
edge where the load is applied.
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Figure 3-1: The x-displacement at Point 27 as a function of time

From the results you can conclude that it takes 500 s for the displacement to increase by 30%.

MODELING USING THE GRAPHICAL USER INTERFACE

Model Navigator
This time the modeling procedure is described as if starting from scratch.

1 Go to the New page in the Model Navigator, then select 2D from the Space dimension list.

2 Select Structural Mechanics Module>Thermal-Structural Interaction>
Plane Stress with Thermal Expansion>Quasi-static analysis.

3 Click OK to close the Model Navigator.

Geometry Modeling
This was described in the static analysis (see the description on page 17 for details).

Physics Settings

Application Mode Properties General Heat Transfer

This is a predefined multiphysics coupling that adds both a Plane Stress and a heat transfer 
application mode (Heat Transfer by Conduction or General Heat Transfer if the license includes the 
Heat Transfer Module). The predefined multiphysics coupling also sets up the thermal expansion on 
the Load page in the Subdomain Settings dialog box for the Plane Stress application mode.
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Skip to the next section if you are using the Heat Transfer by Conduction application mode.

1 Select Properties from the Physics menu to open the Application Mode Properties dialog box.

2 From the Out-of-plane heat transfer list box select Enabled, then click OK.

Boundary Settings Plane Stress

This model uses the same boundary conditions for the Plane Stress application mode as for the static 
analysis (see page 22 for details).

1 Select Plane Stress from the Multiphysics menu.

2 Apply boundary settings according to “Boundary Settings” on page 22.

Boundary Settings Heat Transfer

1 Select Heat Transfer by Conduction from the Multiphysics menu, or General Heat Transfer if 
you are using the Heat Transfer Module.

2 Set boundary conditions for the heat transfer application mode according to the following table. Click 
OK when done.

An easy way to apply the settings is if you first select all boundaries, then apply the Heat flux
boundary condition according to the last two columns of the table. Finish by changing the settings 
for boundary 1 and 12 according to the table.

BOUNDARY 1 BOUNDARY 
12

BOUNDARIES 2
–11, 13–30

Boundary 
condition

Temperature Temperature Heat flux

T0 20[degC] T0 500
[degC]

Tinf 20[degC]

h 5[W/
(m^2*K)]

Subdomain Settings Plane Stress

The material properties for the Plane Stress application mode are the same as in the static analysis on 
page 22.
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Specify the reference temperature in the Plane Stress application mode. The temperature coupling is 
already defined because you used the predefined multiphysics coupling node in the Model Navigator.

1 Select Plane Stress from the Multiphysics menu.

2 Set the reference temperature for the Plane Stress application mode according to the following 
table:

SUBDOMAIN 1

Page Load

Tempref 20
[degC]

You can see that the variable T, which is the temperature from the heat transfer application mode, is 
entered by default in the Temp edit field.

Subdomain Settings Heat Transfer by Conduction

Skip to the next section if you are using the General Heat Transfer application mode from the Heat 
Transfer Module.

Specify the material properties for the heat transfer application mode. The cooling of the surfaces is the 
same as for the boundaries, but you must transform it into cooling per volume, taking into account the 
thickness of the plate and that it has two sides. Instead of 5, htrans is 2500 coming from division by the 
thickness and multiplication by 2.

1 Select Heat Transfer by Conduction from the Multiphysics menu.

2 Set the subdomain settings for the heat transfer application mode according to the following table. 
Click OK when finished.

SUBDOMAIN 1

Page Physics

Library 
material

Structural steel

Text 20[degC]

htrans 2500[W/
(m^3*K)]

Subdomain Settings General Heat Transfer

Skip to the next section if you are using the Heat Transfer by Conduction application mode.
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1 Select General Heat Transfer from the Multiphysics menu.

2 Set the subdomain settings according to the following table, then click OK.

SUBDOMAIN 1

Page Conduction

Library 
material

Structural 
steel

Page Out-of-Plane

hu 5[W/(m^2*K)]

hd 5[W/(m^2*K)]

Text,u 20[degC]

Text,d 20[degC]

dz 4[mm]

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in the Solver 
Parameters dialog box. The option is enabled as the default so there is no need to change the solver 
settings. The time-dependent solver is the one associated with the quasi-static transient analysis type. 

Specify the time-dependent solver parameters:

1 Select Solver Parameters from the Solve menu to open the Solver Parameters dialog box.

2 Enter 0:50:1000 in the Times edit field. This means that the software saves the solution every 50
s during the total solution time of 1000 s. This does not influence the time-stepping length, only the 
times when the solution is saved.

3 Click OK.

4 To compute the solution either click the Solve button (=) on the Main toolbar or select Solve 
Problem from the Solve menu.

Postprocessing and Visualization
Look at the final temperature distribution together with the deformed geometry.

1 Select Plot Parameters from the Postprocessing menu.

2 Select the Deformed shape check box in the Plot type area.

3 Go to the Surface page and select Heat Transfer by Conduction (ht)>Temperature (or 
General Heat Transfer (htgh)>Temperature) from the Predefined quantities list.

4 Click OK to close the Plot Parameters dialog box.
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For a quantitative view of the time evolution of the displacement, plot the x-displacement at the lower-
left corner as a function of time.

1 Select Domain Plot Parameters from the Postprocessing menu.

2 Go to the General page and select all the time steps in the Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 from the Point selection list.

5 Select x-displacement from the Predefined quantities list.

6 Click Apply to plot the x-displacement.

7 Click OK to close the Domain Plot Parameters dialog box.
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